# Contents

## About this Guide

## General Information

## System Set Up for Tasks/Worklog Functionality

- **Security Settings**
  - Recommended Security Settings for Management Staff
  - Recommended Security Settings for Non-Management Staff
  - Controlling the Transferring of Tasks

- **System Settings for Alerts and Required Fields**
  - Alerts Tab
  - Tasks Tab

- **Customizing the Worklog Display**
  - Do not refresh worklog after updating tasks
  - The Worklog Manager real time column display

- **Task Completion Reasons**

- **Task Workgroups**

- **Configuring Task Types**
  - Source Type
  - Task Value

- **Practice Parameters**
  - Options Tab
  - Auto Creation Tab
  - Auto Create Location, Rendering and Payer/Fin Class Tabs
  - Auto Completion Tab
  - Auto Worker Tab

## Creating Tasks

- Manually Assigning Tasks on Demand
- Appointment Task Options
- Account Task Options
- Encounter Task Options
- Chart Task Options
- Invoice Task Options
- User Task Options
Assigning Tasks from Reports ................................................................. 21
Appointment Tasks ....................................................................................... 21
Account Tasks ............................................................................................... 21
Chart Tasks .................................................................................................... 21
Encounter Tasks ............................................................................................. 21
Invoice Task Options .................................................................................... 21

Worklog Manager Display ........................................................................... 23
Worklog Filters ............................................................................................... 24

“Best Practice” Task Examples ................................................................. 25
Front Office Tasks .......................................................................................... 25
Obtain Authorization/Referral ........................................................................ 25
New Patient Information ............................................................................... 26
Waiting List Patients ....................................................................................... 27
Appointment Scheduled for Non-Participating Provider .......................... 28
Appointment Reschedule List (“Bump List”) ............................................... 29
Appointment Report Information ............................................................... 29

Accounts Receivable Follow Up Tasks ....................................................... 30
Patient Credit Balances ............................................................................... 30
Insurance Credit Balances ........................................................................... 30
Statement Indicator Turned Off – Account level ....................................... 31
Statement Indicator Turned Off – Chart level ............................................. 31
Statement Indicator Turned Off – Encounter level .................................... 31
Patients Not Making Acceptable Payments .............................................. 32
Large Patient Balances ............................................................................... 33
Budget Has Become Pre-Listed ................................................................... 33

Follow Up All Outstanding Insurance Balances ........................................ 34
Follow Up Unpaid Invoices ......................................................................... 35
Accounts Receivable Report Information ................................................... 35
Setting up Auto Worker Options ............................................................... 36
Creating Account Alerts ............................................................................. 36
Creating Chart Alerts .................................................................................. 36
Moving Unpaid Insurance Balances to Patient Responsibility .................. 37
Small Balance Write Offs ............................................................................ 38
Scanning Fee Tickets for Charge Entry ..................................................... 39

Monitoring Tasks and User Productivity ................................................... 40
Reports...........................................................................................................................40
Task Analysis Report....................................................................................................40
Task Details Report .................................................................................................41

Appendix A – Task Configuration Options 42

Account Task Actions..............................................................................................42
Appointment Waitlist Task Options .............................................................................46
Appointment Task Options ......................................................................................47
Chart Task Options .................................................................................................49
Encounter Task Options..........................................................................................51
Invoice Task Options ...............................................................................................58
User Task Options ....................................................................................................58
About this Guide

Purpose
This guide was developed to provide information on how to configure and use the Task/Worklog feature in the NextGen® EPM system. The flexibility within the Task configuration is designed to adapt to the business rules and policies of each organization.

The “Best Practices” section in this guide is designed to share information about how other NextGen® customers have utilized this functionality to meet the specific business needs of their organization. Many of the set up options described here can be customized to meet the unique needs of an organization.

These are to be used as guidelines, and intended to be somewhat generic.

Audience
This guide is intended for use by all NextGen® EPM application clients.

Assumptions
Users knowledge base should meet if not exceed the following:
- Working knowledge of NextGen® EPM application
- Basic understanding of tasking
- Basic computer skills
General Information

The NextGen® Tasks/Worklog manager is a powerful tool that can be used to automatically or manually assign and complete specific tasks. From appointment scheduling to accounts receivable follow up, tasks can be used to automate workflow in a typical medical office.

Using the Task reporting capabilities, employee productivity and workload can be monitored and evaluated.

For a complete overview of the tasking functionality, please refer to the NextGen® EPM User Guide.
System Set Up for Tasks/Worklog Functionality

Security Settings
Security settings control user access to tasks and associated task functionality. These settings are made at the Group level in System Administrator.

Recommended Security Settings for Management Staff

Modules
- File Maintenance > Task Types = View, Add, Update, Delete, Print
- File Maintenance > Task Workgroups = View, Add, Update, Delete, Print
- Tasks = View, Add, Update, Delete, Print

Operations
- Tasks = Yes
  - Tasks Auto Create Discontinue = Yes
  - Task Instruction Modification = Yes
  - Task Manager = Yes
  - Task Reports = Yes
  - Task Transfer = Yes
  - Task Update = Yes
Recommended Security Settings for Non-Management Staff

Modules

- File Maintenance > Task Types = View, Print
- File Maintenance > Task Workgroups = View, Print
- Tasks = View, Add, Update

Operations

- Tasks = Yes
  - Tasks Auto Create Discontinue = Yes
  - Task Instruction Modification = No
  - Task Manager - *See the section on “Controlling the Transferring of Tasks”
  - Task Reports = No
  - Task Transfer = Yes
  - Task Update = No
Controlling the Transferring of Tasks

The ability to transfer tasks is controlled by using the **Secured Transfer to** option in the Task Type setup and the **Task Manager** security option.

The Task Manager security option in System Administrator does the following:

- **Task Manager = Yes**
  The user can transfer tasks to any other User or any Task Workgroup.

- **Task Manager = No**
  The user can transfer tasks only to Task Managers or to those Users/Work Groups designated in the “Secured Transfer to” field within the Task Type setup.

If the Task Manager security option is not assigned to anyone in the practice, Tasks cannot be transferred between users except as designated in the Secured Transfer To option on the Task Type.

The Secured Transfer To option in the Task Type allows the designation of specific users or Task Workgroups as those allowed to receive this task from other users. Any users or Task Workgroups entered in this field will always be available as options when a user is transferring a task.
System Settings for Alerts and Required Fields

System alerts and required fields are set in Practice Preferences.

Alerts Tab
To display account alerts when opening a task

Account Alerts > Task

To display chart alerts when opening a task

Chart Alerts > Task

Tasks Tab

Set Required Fields

The following is a list of fields that can be set as required

<table>
<thead>
<tr>
<th>Field Name</th>
<th>NextGen® Recommended Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>√</td>
</tr>
<tr>
<td>Details</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>√</td>
</tr>
<tr>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>Assigned To</td>
<td>√</td>
</tr>
<tr>
<td>Start Date</td>
<td></td>
</tr>
<tr>
<td>Completed By</td>
<td>√</td>
</tr>
<tr>
<td>Completed Date</td>
<td>√</td>
</tr>
<tr>
<td>Completed Reason</td>
<td></td>
</tr>
</tbody>
</table>

Set Automatic Options

The following is a list of options that can be set as defaults and restrictions

<table>
<thead>
<tr>
<th>Option Name</th>
<th>NextGen® Recommended Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Completed By with Current User</td>
<td>√</td>
</tr>
<tr>
<td>Default Completion Date with Current Date</td>
<td>√</td>
</tr>
<tr>
<td>Do Not Allow Past Completion Dates</td>
<td>√</td>
</tr>
<tr>
<td>Do not Allow Modification of Completion Date</td>
<td>√</td>
</tr>
<tr>
<td>Do not Allow Modification of Completed By</td>
<td>√</td>
</tr>
<tr>
<td>Skip claim edit with completed task</td>
<td></td>
</tr>
</tbody>
</table>
Note: The “Skip claim edit with completed task” option is designed to allow review of specific claim edits. Once the task has been reviewed and completed, the claim attached to that encounter will not go back through the claim editing process, even if the error is not corrected.

Customizing the Worklog Display

Users are able to customize how Worklog information displays their tasks by selecting the desired options on the task tab in User preferences. Users are able to set the following preferences:

- Do not refresh worklog after updating tasks
- The Worklog Manager real time column display

Users access these options from the main menu by

Admin > Preferences > User > General > Task tab

Do not refresh Worklog after updating tasks

The “Do not refresh Worklog after updating tasks” option will act as the default setting when using the Worklog. Selecting this option will allow the user to continue working down the list without having to wait for the list to refresh after every update. This will expedite using the Worklog and allow the user to retain their place in the list once a task is completed. The list is refreshed manually at any time by selecting the “Find” option.

The Worklog Manager real time column display

“The Worklog Manager real time column display” options allow each user to determine which real time data columns to return when using the worklog. The real time columns will be indicated on the worklog with clock icons.

It is recommended that each user select only the columns that contain data needed for that employee. For example, if the user will not be working on appointment tasks, it would not be necessary to select the appointment data column.
Task Completion Reasons

Task completion reasons can be found in **File Maintenance > Master Lists**. The following is the list of standard reasons available for pre-load using the NextGen® Go-Live Wizard. Users should be aware that at least one completion reason is required before tasks are set up to complete automatically.

- Adjustment Made
- Automatically Completed
- Contacted Patient
- Contacted Insurance
- Corrected Error
- Not Completed in Time by User
- Paid
- Pre-Cert Done
- Referral Entered
- Referral Received
- Re-filed Claim
- Set up Payment Plan
- Statement turned off per Physician
- Task Completed Successfully

Task Workgroups

Task Workgroups are found in **File Maintenance > Master Files > Practice**. Tasks are assigned to one user, or to a group of users. Task Workgroups allow users to be grouped together to assign EPM tasks.

The list below gives some examples of common workgroups:

- Commercial Claim Follow Up Team
- Medicare Claim Follow Up Team
- Medicaid Claim Follow Up Team
- Referral/Authorization Coordinators
- Charge Entry Staff
- Denial Follow Up Staff

**Note:** Some clients report that it is easier to manage Task Workgroups than to change individual tasks when they encounter employee turnover. Task Workgroups can contain only one user or multiple users and can be assigned to one or more tasks.
Configuring Task Types

Tasks Types are set up in the File Maintenance application from **Master Files > System > Task Type > New**. The name of the task, the Task Value and Source Type fields are shared among all practices within an enterprise. All other information and configuration options are unique to the practice in which they are created. This information displays in the *Practice Parameters* section of the Task Type window.

For a complete list of all the Auto Creation, Auto Completion, and Auto Worker configurations, see Appendix A.

![Task Types](image)

### Source Type

*Source Type* determines the configuration options for the task; where it is used and viewed within the NextGen®, and what data will be available for the task.

- Account (Employer and Patient Accounts)
- Appointment
- Appointment Waitlist
- Chart
- Encounter
- Invoice
- User

### Task Value

*Task Value* is used to determine the relative weight of a task. Can be used for productivity measurement and reporting.
Practice Parameters
The following are practice parameters tabs. The options available are unique to the practice in which they are created.

Options Tab
The Options Tab allows users to set the following task options:

- **Generate System Alert**: creates an alert when accessing the patient that has this task assigned.
- **Default Priority**: High, Low, Normal
- **Default Assigned To**: Used to determine whom the task will be assigned to when it is manually created or created through claims edits. The assignment of manually created tasks can be overridden at the time of task creation. If this field is left blank, it will require the user to select a user or Task Workgroup when the task is created.
- **Secured Transfer To**: Limits the users and Task Workgroups available when transferring a Task. If the user has the Task Manager security, this limitation will not apply.
- **Discontinue future auto creation of this task type**: Once a task is marked completed, this option prevents additional tasks of the same type from being automatically created for the specific source.
Auto Creation Tab

Once a Source Type is selected, the auto creation options unique to that Source Type will display.

Tasks can be automatically created if the criteria defined on this tab are met. Tasks will not be re-created if there is an existing open task for the source and task type.

- **Default Assigned to for all selected actions:** Task Workgroups or individual Users selected here are assigned automatically to any tasks automatically created from the action(s) selected unless otherwise specified in the Override assigned to field.

- **Activate:** It is necessary to place a green check next to any and all actions users would like to activate for automatic creation of this task.

- **Action:** The actions listed are hard coded by the system and contingent on the Source Type selected. Each Source Type has a different set of associated options. To configure the specifics of the action, users right-click on the action and select **Open**. A dialogue box displays.

  Auto-create actions are considered “OR” conditions. In other words, if users select more than one of these options a task will automatically be created if the source meets either of these conditions – it does not have to meet all the conditions selected, just any one of them.

- **Override assigned to:** Task Workgroups or individual Users selected here will be automatically assigned any tasks that are created from this specific action.

- **Processed:** Tasks using auto-create function have two options: Nightly or immediately. The tasks that say “nightly” will create when the Task Update process is run, either automatically during a nightly SQL job, or manually from within the NextGen® EPM application from the **File > Processes > Task Update** menu option. The exceptions are tasks that use counters (e.g. dates greater than “x”). They will not update during the manual process until the date criteria is satisfied.
Auto Create Location, Rendering and Payer/Fin Class Tabs

Once a Source Type is selected, the Auto Create Location; Rendering; Payer/Fin Class options unique to that Source Type are available as follows:

- Appointment - Auto Create Location, Auto Create Rendering
- Appointment Waitlist - Auto Create Location, Auto Create Rendering
- Encounter - Auto Create Location, Auto Create Rendering, Auto Create Payer/Fin Class

This option does not apply to Account, Chart, Invoice, and User tasks.

Where applicable, these options allow one method to automatically assigning tasks to a Task Workgroup or individual user.

Once data is entered into one of the available tabs, the other tabs will be no longer accessible.

To enter data, select a Location, Rendering, Payer or Financial Class; then select a User or Task Workgroup. Use the blue arrow to move the User/Task Workgroup into the “Selected” area. One or more Users/Task Workgroups can be added per Location, Rendering, Payer or Financial Class. Any Locations, Renderings, Payers or Financial Classes left blank will use the “Default Assigned To” selection on the Auto Creation tab.
Auto Completion Tab

Once a Source Type is selected, the Auto Completion options unique to that Source Type will be available for selection.

- **Default Completion Reason for all selected actions:** The Completion Reason selected will be used on any tasks that are automatically completed from the action(s) selected unless otherwise specified in the Override completion reason field.

- **Activate:** It is necessary to place a green check next to any and all actions that users would like to activate for automatic completion of this task. These actions are “OR” conditions. Satisfying any one of the selected parameters will complete the task.

- **Action:** The actions listed here are hard coded by the system and contingent on the Source Type selected. Each Source Type has a different set of associated options. To configure the specifics of the action, users right-click the action to activate it and select **Open**. A dialogue box displays to enter the parameters.

- **Override completion reason:** Completion Reasons selected here will be used on any tasks that are completed from this specific action.
Auto Worker Tab

Once a Source Type is selected, the Auto Worker options unique to that Source Type will be available for selection. Each Auto Worker action has specific Auto Create actions designed to work with that Auto Worker feature. To determine the appropriate Auto Creation action choices, users will right-click the Auto Worker action and select **Auto Create Actions**. This highlights all available Auto Creation actions in blue. At least one Auto Create action must be activated before the Auto Worker action can be configured.

- **Activate**: It is necessary to place a green check next to any and all actions users would like to activate for automatic completion of this task.

- **Action**: Actions listed here are hard coded by the system and contingent on the Source Type selected. Each Source Type has a different set of associated options. To configure the specifics of the action, users right-click the action to activate it and select **Open**. A dialogue box displays.
Creating Tasks

Tasks are created manually, on an “as needed” basis, or automatically by the NextGen® EPM application. The options to create them depend upon the Source Type of the task.

Manually Assigning Tasks on Demand

Tasks can be added one at a time, when a specific issue is identified for tracking and/or follow up.

Appointment Task Options

From the Appointment Book or Appointment List:

- Right-click the appointment and select Tasks
- Open an appointment and select the Task/Prov tab; right-click in the Tasks section and select New

Account Task Options

- In the Account Profile, select the Notes tab, select the Tasks folder; right-click and select New
- Within the Transaction Entry screen (with a source of Account, Budget, or Invoice), select the New Task icon

Encounter Task Options

- From the Patient Chart or Encounter Look up screen, right-click the encounter and select Tasks
- Within the Charge Posting screen (in Encounter mode), select the New Task icon
- Within the Transaction Entry screen (with a source of Encounter), select the New Task icon

Chart Task Options

- In the patient chart, select the Clinical History/Notes tab select the Tasks folder; right-click and select New

Invoice Task Options

- In the Account Profile (Employer account), select the Notes tab, select the Tasks folder; right-click and select New
- Within the Charge Entry screen (in Invoice mode), select the New Task icon

User Task Options

- From the Tasks menu, select Create Task
Assigning Tasks from Reports

Tasks are manually created in bulk from reports using the “Assign Task” icon.

Appointment Tasks
- Reports > Scheduling > Appointment Listing
- Reports > Scheduling > Kept Appointments w/no Charges

Account Tasks
- Reports > General > Statements
- Reports > Accounts Receivable > Budget Reports
- Reports > Accounts Receivable > Collections > Account Summary

Chart Tasks
- Reports > General > Patient Chart Demographics
- Reports > General > Patient Chart Demographics with Providers
- Reports > General > Patient Recall

Encounter Tasks
- Reports > General > Claim Requests
- Reports > General > Patient Insurance Listing
- Reports > Accounts Receivable > Aging Analysis
- Reports > Accounts Receivable > Billed Encounters
- Reports > Accounts Receivable > Unbilled Encounter
- Reports > Accounts Receivable > Collections > Insurance Aging Analysis
- Reports > Accounts Receivable > Collections > Insurance Detail
- Reports > Accounts Receivable > Collections > Insurance Summary
- Reports > Accounts Receivable > Collections > Collections FollowUp
- Reports > Daily > Charges
- Reports > Daily > Encounters

Invoice Task Options
- Reports > Accounts Receivable > Aging Analysis
- Reports > Accounts Receivable > Collections > Insurance Aging Analysis
- Reports > Accounts Receivable > Collections > Insurance Detail
- Reports > Accounts Receivable > Collections > Insurance Summary
- Reports > Daily > Charges
Worklog

Once a task is created and assigned, it appears in the user’s Worklog. Users access their Worklog from any of the following locations:

- The Worklog Icon on the main toolbar
- The Tasks section of the Advisor screen
- The Open Task indicator on the bottom status bar
Worklog Manager Display

The Worklog Manager window is used to look up tasks based on the search criteria entered. The window is designed to allow users to configure the columns in the order that provides the most clear and pertinent data. To begin, the user should select “My Tasks”, which will automatically bring up all tasks assigned to the user (or to a workgroup to which the user belongs) that have a status of “In Progress” or “Not Started”.

The columns can be re-arranged by dragging and dropping them into place and will remain in this order unless manually reset. To reset the column order, right-click on the blue area of the top toolbar and select the “Reset desktop settings” options.

Note: This option resets all column settings within the NextGen® EPM application.

Data in the Worklog Manager is ordered by clicking on the column name. For example, to list tasks by account balance, click the “Acct Bal” column heading. This puts the column in ascending order. To put the information in descending order (highest balance first), click the column heading again.
Worklog Filters

The Advanced tab allows additional filtering capability to prioritize the tasks. Multiple conditions can be configured to ensure users are working on the highest priority items.
“Best Practice” Task Examples

Front Office Tasks
The following are some examples of tasks that can be automatically or manually assigned to assist the front office staff in following up on specific action items.

Obtain Authorization/Referral
**Purpose:** An appointment is made but there is not an authorization/referral on file for this service. The staff would manually create this task to the patient’s appointment. It can be automatically assigned when building the Task Type or manually assigned when created.

**Source Type:** Appointment

**Auto-Create Option:** None

If the authorization/referral is needed for specific events only, the following options can be used:
- Event <Unknown> is schedule
- Event <Unknown> is scheduled at Location <Unknown>

**Auto-Complete Options:**
- Appointment cancelled
- Appointment deleted
- Patient expired

**Auto-Worker Option:** None
New Patient Information

Purpose: When an appointment is made for a new patient a task can automatically be created and directed to the appropriate staff for action. This could include setting up a new chart; performing a pre-registration; or sending the patient practice information. The auto-create action should contain all Event types that represent new patients in your organization.

Source Type: Appointment

Auto-Create Option: Event <New Patient> is scheduled

Auto-Complete Options:
- Appointment cancelled
- Appointment deleted
- Patient expired

Auto-Worker Option: None
Waiting List Patients

**Purpose:** To utilize the Waitlist functionality that automatically queues patients that are waiting for an earlier appointment. The use this feature, it must be enabled in **Practice Preference > Wait List** tab.

The "Minimum Lead Time to Generate a Waitlist Worklog Task" feature allows the user to set the amount of time (in minutes) required as advanced notice to schedule an appointment from the wait list.

**Source Type:** Appointment Waitlist

**Auto-Create Options:**
- Waitlist batch update to match potential candidates to open appointment slots
- Waitlist matches open slot

**Auto-Complete Options:**
- Waitlist completed successfully
- Waitlist modified or deleted
- Waitlist no longer has open slot available
- Waitlist no longer matches open slot due to another appointment being booked

**Auto-Worker Option:** None
Appointment Scheduled for Non-Participating Provider

**Purpose:** Identify patients who have an appointment scheduled with a provider that does not participate in their insurance.

**Note:** Tracking provider participation in insurance plans requires a Contract Library be created and attached to the Payer Master File > Practice Tab > Libraries subtab. No fee schedule is required to use this feature.

**Source Type:** Appointment

**Auto-Create Option:** Rendering does not participate in primary insurance plan

**Auto-Complete Options:**
- Appointment cancelled
- Appointment deleted

**Auto-Worker Option:** None
Appointment Reschedule List ("Bump List")

**Purpose:** Identify patients who need to have their appointments rescheduled due to a change in the appointment schedule.

**Source Type:** Appointment

**Auto-Create Option:** Appointment no longer matches the resource’s template due to a template exception.

**Auto-Complete Options:**
- Appointment cancelled
- Appointment kept/checked in

**Auto-Worker Option:** None

Appointment Report Information

**Purpose:** Isolate information using a customized appointment listing report and task only those items. Some examples include: all patients who had a no show or cancelled appointment for the previous week (using Filter 1 options); all patients who have a patient balance greater than $x.xx that have an appointment for tomorrow (using Filter 2 options).

Once the report is created, select the Assign Tasks icon.

**Source Type:** Appointment

**Auto-Create Option:** None

**Auto-Complete Options:**
- Appointment cancelled
- Appointment deleted
- Patient expired

**Auto-Worker Option:** None
Accounts Receivable Follow Up Tasks
These tasks can be automatically created to identify third party and patient balances for follow up or other action.

Patient Credit Balances

Purpose: Identify patient accounts with an overall credit balance in patient responsibility.

Source Type: Account

Auto-Create Option: Guarantor balance is between 

Auto-Complete Options:
- Account balance of $0.00

Auto-Worker Option: None

Insurance Credit Balances

Purpose: Identify encounters with a credit balance outstanding to a third party payer.

By selecting all financial classes in the COB1 position, any third party balance will be captured, regardless of where the outstanding credit resides. For example, if Medicare is primary and the credit balance is outstanding to the secondary payer, BCBS, this task will still create because Medicare was in the primary position and the balance meets the criteria.

Source Type: Encounter

Auto-Create Option: Encounter is greater than <X> days old from <___> and 3rd party balance is between 

Auto-Complete Options:
- Encounter reaches History status
- Third party of balance of $0.00

Auto-Worker Option: None
Statement Indicator Turned Off – Account level

**Purpose:** Identify patient accounts with than have had the statement indicator turned off. These patients would not be receiving a statement for any of the encounters attached to the account.

**Source Type:** Account

**Auto-Create Option:** Print statements indicator turned off for more than <30> days

**Auto-Complete Options:**
- Print statements indicator turned on

**Auto-Worker Option:** None

Statement Indicator Turned Off – Chart level

**Purpose:** Identify patient charts with than have had the statement indicator turned off. These patients would not be receiving a statement for any encounters on that chart.

**Source Type:** Chart

**Auto-Create Option:** Print statements indicator turned off for more than <30> days

**Auto-Complete Options:**
- Print statements indicator turned on

**Auto-Worker Option:** None

Statement Indicator Turned Off – Encounter level

**Purpose:** Identify patient encounters with than have had the statement indicator turned off. These patients would not be receiving a statement for that encounter.

**Source Type:** Encounter

**Auto-Create Option:** Print statements indicator turned off for more than <30> days

**Auto-Complete Options:**
- Print statements indicator turned on

**Auto-Worker Option:** None
Patients Not Making Acceptable Payments

**Purpose:** Identify patient accounts where the patient has not made an acceptable payment in a certain time period.

**Note:** The acceptable payment criteria is entered in Practice Preferences > Statements tab. Setting this parameter activates the “Statement Counter” feature on the patient account. Once this parameter is defined, every time the patient receives a statement, the statement counter will add one number to the counter. If the patient makes an acceptable payment, it will be automatically reset to “O”. For example, if a patient receives three statements without making an acceptable payment, they will have a statement counter of “3”.

**Source Type:** Account

**Auto-Create Option:** Account statement counter is greater than <3>

**Auto-Complete Options:**
- Account balance of $0.00
- Patient payment greater than <acceptable payment amount> posted

**Auto-Worker Option:** None
Large Patient Balances

**Purpose:** Identify accounts with large patient balances.

**Note:** The “date of patient responsibility” is automatically assigned to each encounter when there is no longer an outstanding insurance balance. For example, if the patient had an unpaid copay balance and an insurance balance, the “date of patient responsibility” would be the date the insurance balance was paid in full and only the patient responsibility amount remained. This task is automatically created if any encounter on the account meets the aging criteria.

**Source Type:** Account

**Auto-Create Option:** Account is greater than <60> days old from <Date of Patient Responsibility> and guarantor balance is greater than <$100.00>

**Auto-Complete Options:**
- Account balance of $0.00

**Auto-Worker Option:** None

Budget Has Become Pre-Listed

**Purpose:** To notify the staff that an account on a Budget plan is delinquent and has become pre-listed for Bad Debt.

**Source Type:** Account

**Auto-Create Option:** Budget has become prelisted

**Auto-Complete Options:**
- Account balance of $0.00

**Auto-Worker Option:** None
Follow Up All Outstanding Insurance Balances

**Purpose:** Identifies all outstanding insurance balances greater than a certain period. These are automatically assigned to different staff members by using the auto create by Rendering, Location and Financial Class tabs.

**Note:** Optionally, separate tasks can be used to identify COB1, COB2 and COB3 balances using these parameters. If selecting that option, it is important to remember that the COB designation within the task only relates to the financial class selected within the parameter, not the current outstanding balance.

It is also possible to use the auto create options “No third party payment received...” to identify unpaid claims. These tasks look at the claim create date and any associated transactions posted for that insurance company.

**Source Type:** Encounter

**Auto-Create Option:** Encounter is greater than <45> days old from <Last Bill Date> and 3<sup>rd</sup> party balance is between <$5.00> and <$99,999.99> for <Financial Class = all selections except Patient Pay> is <COB = 1> and encounter status is <Billed>.

**Auto-Complete Options:**
- Encounter reaches History status
- Third party balance of $0.00
- Clean claim created

**Note:** Selecting this option automatically complete the task if the encounter is rebilled. The task would automatically re-create again in 45 days if the balance parameter was not satisfied at that time.

**Auto-Worker Option:** None
Follow Up Unpaid Invoices

**Purpose:** Identify all outstanding invoices that match the configuration criteria.

**Source Type:** Invoice

**Auto-Create Option:** Invoice is greater than <45> days old from <Last Bill Date> and balance is greater than <$5.00>.

**Auto-Complete Options:**
- Invoice reaches History status

**Auto-Worker Option:** None

Accounts Receivable Report Information

**Purpose:** Isolate information using a customized accounts receivable report and task only those items. Some examples include: One specific service item that is not being paid by many insurance carriers; all outstanding balances for one specific insurance company for one specific provider. Once the report is created, select the Assign Tasks icon.

**Source Type:** Encounter

**Auto-Create Option:** None

**Auto-Complete Options:**
- Encounter reaches History status

**Auto-Worker Option:** None

**Source Type:** Account

**Auto-Create Option:** None

**Auto-Complete Options:**
- Account Balance $0.00

**Auto-Worker Option:** None
Setting up Auto Worker Options

There are multiple pre-configured options that automatically perform specific functions. The task is created and put into the patient’s chart, then marked completed by the Auto Worker. The following are some examples of how these are used by other NextGen® customers to automate their processes.

Creating Account Alerts

**Purpose:** Identifies all patients with a large balance and put an alert on their account to have them speak with someone in the patient collections department.

**Source Type:** Account

**Auto-Create Option:** Account is greater than <45> days old from <Date of Patient Responsibility> and balance is greater than <$200.00>.

**Auto-Complete Options:**
- Account reaches History status

**Auto-Worker Option:** Create account alert with subject “Patient Needs to Speak with Financial Counselor”, expiration date 00/00/00, description “Do not make appointment until patient speaks with financial counselor”

Creating Chart Alerts

**Purpose:** Identifies all patients with that have privacy notice restrictions by putting an alert on their chart.

**Source Type:** Chart

**Auto-Create Option:** Privacy Notice reason set to “Privacy restrictions on this patient”

**Auto-Complete Options:**
- Account reaches History status

**Auto-Worker Option:** Create a chart alert with subject “Privacy restrictions on this patient” expiration date 00/00/00, description “Do not release any information until privacy restrictions are reviewed.”
Moving Unpaid Insurance Balances to Patient Responsibility

Purpose: Identifies all unpaid claims that should have the balance moved to patient responsibility. This can be used for primary or secondary claims in accordance with the business rules of the organization.

Primary Claims:
Source Type: Encounter

Auto-Create Option: No third party payment received for <45> days since the claim process date for <Financial Class = Auto Accident; Non-contracted Commercial> where <Financial class = COB1>.

Auto-Worker Option: Move balance from “COB1” to “Next Responsible Party”

Secondary Claims:
Source Type: Encounter

Auto-Create Option: No third party payment received for <45> days since the last third party payment received and third party balance is greater than <$1.00> for <Financial Class = Non-contracted Commercial> where <Financial class = COB2>.
Small Balance Write Offs

**Purpose:** Identifies small balances available for review and write off. These options automatically create a transaction batch that must be reviewed and posted by the staff.

**Patient Balances Only:**

**Source Type:** Encounter

**Auto-Create Option:** Encounter is greater than <40> days old from <Date of Patient Responsibility> and the patient balance is less than <1.00> for <Financial class = Commercial, Blue Cross, Patient Pay> is <COB=1> and encounter status is <Billed>.

**Auto-Worker Option:** Small balance write-off using transaction code <Small Balance write-off>

**Patient and Insurance Balances:**

**Source Type:** Encounter

**Auto-Create Option:** Encounter is greater than <40> days old from <Last Bill Date> and the total balance is less than <1.00> for <Financial class = Commercial, Blue Cross, Patient Pay> is <COB=1> and encounter status is <Billed>.

**Auto-Worker Option:** Small balance write-off using transaction code <Small Balance write-off> for patient balance, transaction code <Small Balance write-off - Ins> for 3rd party balance
Scanning Fee Tickets for Charge Entry

User tasks can be automatically created from the Image Control System (ICS). Document Types can be configured to automatically create a task when documents are scanned through ICS. When creating the Document Type, select the Document Type Template “NextGen Fee Tickets”.

When a Document Type that is configured with this template is scanned using ICS, it will automatically create a task to allow the user to post the charges from the scanned fee tickets, automatically attaching the scanned image to the charge.

Source Type: User

Auto-Create Option: Fee Ticket Document Type of <Fee Tickets> is posted

Auto-Complete Options: None

Auto-Worker Option: None
Monitoring Tasks and User Productivity

Reports

There are two reports designed to review the task allocation and assist in monitoring staff accountability. Also can be used to ensure that workload is evenly distributed among staff.

Task Analysis Report

Purpose: Provides an overview of all tasks and the current status of those tasks.

Reports> Tasks > Task Analysis

Columns: Select all columns except ST (Source Type abbreviation)
Sorting: Group by User Name

Example:

<table>
<thead>
<tr>
<th>Type/Date</th>
<th>Task Code</th>
<th>Hr Opm</th>
<th>Per Opm</th>
<th>Hr Cmp</th>
<th>Per Cmp</th>
<th>Hr Over</th>
<th>Per Over</th>
<th>Hr Hot St</th>
<th>Per Hot St</th>
<th>Hr In Prg</th>
<th>Per In Prg</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/26/08 1:53 PM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Anderson, Sarah | 1 | 1 | 100 | 0 | 0 | 0 | 0 | 1 | 100 | 0 | 0 |
| Armstrong, Roger| 1 | 1 | 100 | 0 | 0 | 0 | 0 | 1 | 100 | 0 | 0 |
| Auto Worker,    | 6 | 1 | 17 | 5 | 63 | 0 | 0 | 0 | 0 | 1 | 17 |
| Auto Worker,    | 15 | 0 | 0 | 15 | 100 | 0 | 0 | 0 | 0 | 0 | 0 |
| Auto Worker,    | 35 | 0 | 0 | 35 | 100 | 0 | 0 | 0 | 0 | 0 | 0 |
| Auto Worker,    | 407 | 0 | 0 | 407 | 100 | 0 | 0 | 0 | 0 | 0 | 0 |

Example of the Fusion Medical Practice Task Analysis
Task Details Report

**Purpose:** Identify specific details about a task and/or user.

**Reports > Tasks > Task Details**

**Columns:** Source Nbr, Name, Type Desc, Start Dt, Due Dt, Fup Dt, Status Desc, Assigned to, Comp Dt

**Assigned to:** Select the employees to review

**Sorting:** Group by Assigned to; Group by Status Desc

Optionally, this could be grouped by Task Type to review the activity of a specific task.

---

**Example:**

<table>
<thead>
<tr>
<th>Source Nbr</th>
<th>Name</th>
<th>Type Desc</th>
<th>Start Dt</th>
<th>Due Dt</th>
<th>Comp Dt</th>
</tr>
</thead>
<tbody>
<tr>
<td>87</td>
<td>Chambers, Witt</td>
<td>Unpaid Secondary Ins Balances</td>
<td>04/06/08</td>
<td></td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>Simpson, Amber</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>149</td>
<td>Boss, OC Medical</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>123</td>
<td>George, Andy</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>118</td>
<td>Simpson, Betty A</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>731</td>
<td>Moreau, Luisa</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>236</td>
<td>Nelson, Isaac</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>801</td>
<td>Martin, James</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>599</td>
<td>Nelson, Isaac</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>803</td>
<td>Madison, James</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>924</td>
<td>Johnson, Nancy</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>114</td>
<td>Coughlin, Joe</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>301</td>
<td>Smith, James</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>146</td>
<td>Johnson, Nancy</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>932</td>
<td>Blake, James</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>933</td>
<td>Carson, Rodney</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>431</td>
<td>Smith, James</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>341</td>
<td>Winter, Thomas</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1510</td>
<td>Bub, Jocinette</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1401</td>
<td>Simpson, Amber</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>819</td>
<td>Simpson, Amber</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>462</td>
<td>Busher, Edith</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>772</td>
<td>Smurman, Linda</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1417</td>
<td>Papine, Robert</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>832</td>
<td>Jones, Clay</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>833</td>
<td>Jones, Darcy</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>359</td>
<td>Winter, Thomas</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>857</td>
<td>Jones, Clay</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1244</td>
<td>Knokker, Betty</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1378</td>
<td>Simpson, Amber</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1871</td>
<td>Smurman, Linda</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2401</td>
<td>Smith, James</td>
<td>Unpaid Primary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1171</td>
<td>Task, Dental</td>
<td>Unpaid Primary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1098</td>
<td>Peterson, James</td>
<td>Follow Up Task Details</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>Chambers, Witt</td>
<td>Unpaid Secondary Ins Balances</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix A – Task Configuration Options

Account Task Actions

The following is a list of the Auto-Create actions available for Tasks with the source type “Account”, the Auto-Complete actions that might be used with them, and the available Auto-worker actions.

<table>
<thead>
<tr>
<th>Auto-Creation Actions</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account is greater than ___ days old from &lt;date option&gt; and guarantor balance is</td>
<td>Account balance of $0.00</td>
<td>Create account alert</td>
<td>Ages from the most current encounter attached to the account</td>
</tr>
<tr>
<td>greater than $_____</td>
<td>Guarantor balance less than $____</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account is greater than ___ days old from &lt;date option&gt; and third party balance</td>
<td>Account balance of $0.00</td>
<td>Create account alert</td>
<td>This can be used for credit balances (between -9999.99 and -0.01)</td>
</tr>
<tr>
<td>between $_____ and $____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account is greater than ___ days old from &lt;date option&gt; and third party balance</td>
<td>Account balance of $0.00</td>
<td>Create account alert</td>
<td>Ages from the most current encounter attached to the account</td>
</tr>
<tr>
<td>is greater than $_____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account is greater than ___ days old from &lt;date option&gt; and total balance is greater</td>
<td>Account balance of $0.00</td>
<td>Create account alert</td>
<td>Combines both insurance and patient responsibility and identifies accounts that meets the defined parameters</td>
</tr>
<tr>
<td>than $_____</td>
<td>Total balance less than $____</td>
<td></td>
<td>Ages from the most current encounter attached to the account</td>
</tr>
<tr>
<td>Auto-Creation Actions</td>
<td>Auto-Completion Actions</td>
<td>Auto-Worker Actions</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account statement counter is greater than ( (X))</td>
<td>• Account balance of $0.00</td>
<td>• Create account alert</td>
<td>• Identifies accounts that have “X” number of statements without making an adequate payment (as defined in Practice Preferences &gt; Statements Tab)</td>
</tr>
<tr>
<td></td>
<td>• Patient payment greater than $___ posted.</td>
<td></td>
<td>• “Patient payments” are defined as payments with the source type of Account.</td>
</tr>
<tr>
<td>Budget has become delinquent</td>
<td>• Account balance of $0.00</td>
<td>• Bad debt pre-list all encounters in budget</td>
<td>• Identifies delinquent budget accounts</td>
</tr>
<tr>
<td></td>
<td>• Budget payment posted</td>
<td>• Bad debt pre-list all encounters in budget</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Budget plan modified</td>
<td>• Create account alert</td>
<td></td>
</tr>
<tr>
<td>Budget has become pre-listed</td>
<td>• Account balance of $0.00</td>
<td>• Bad debt pre-list all encounters in budget</td>
<td>• Identifies budgets that are pre-listed for Bad Debt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create account alert</td>
<td></td>
</tr>
<tr>
<td>Budget must be re-established – payment amount is now too low</td>
<td>• Budget plan modified</td>
<td>• Create account alert</td>
<td>• References the required minimum in Practice Preferences &gt; Budget tab</td>
</tr>
<tr>
<td>Budget payment missed</td>
<td>• Budget plan modified</td>
<td>• Create account alert</td>
<td>• Identifies budget payments that were not made</td>
</tr>
<tr>
<td></td>
<td>• Budget payment posted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Budget plan modified</td>
<td></td>
<td></td>
<td>• Identifies budget plans that have been changed by a user.</td>
</tr>
<tr>
<td>Collection letter printed</td>
<td>• Patient payment greater than $___ posted.</td>
<td>• Create account alert</td>
<td>• Identifies accounts that have had a Demand Encounter Letter printed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• “Patient payments” are defined as payments with the source type of Account.</td>
</tr>
<tr>
<td>Guarantor balance between $___ _ and $____</td>
<td>• Account balance of $0.00</td>
<td>• Create account alert</td>
<td>• This can be used for credit balances (between -9999.99 and -0.01)</td>
</tr>
<tr>
<td></td>
<td>• Guarantor balance less than $_____</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Guarantor balance between $____ and $____, third party balance of $0.00</td>
<td>• Account balance of $0.00</td>
<td>• Create account alert</td>
<td>• Identifies accounts with patient balance and no insurance balances.</td>
</tr>
<tr>
<td></td>
<td>• Total balance less than $______</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-Creation Actions</td>
<td>Auto-Completion Actions</td>
<td>Auto-Worker Actions</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------</td>
<td>---------------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| Guarantor balance greater than $____ | Account balance of $0.00  
Guarantor balance less than $____ | Create account alert | Identifies accounts with a patient responsibility that meets the parameters. |
| Guarantor balance less than $____ | Account balance of $0.00 | Create account alert | Not intended to identify credit balances. |
| Guarantor responsibility is greater than _____ days old from <date option> & guarantor balance is greater than $____ | Account balance of $0.00  
Guarantor balance less than $____ | Create account alert | The date of patient responsibility is added to an encounter when all insurance balances are $0.00.  
Ages from the most current encounter attached to the account |
| Guarantor responsibility is greater than _____ days old from <date option> & guarantor balance between $____ & $______ | Account balance of $0.00  
Guarantor balance less than $____ | Create account alert | This can be used for credit balances (between -9999.99 and -0.01). |
| Guarantor responsibility is greater than _____ days old from <date option> & guarantor balance between $____ & $_____; third party balance of $____ | Account balance of $0.00  
Total balance less than $____ | Create account alert | Identifies accounts with both a patient AND an insurance balance that meet the defined parameters, |
| Minimum budget payment not met | Budget has become pre-listed  
Budget plan modified  
Guarantor balance less than $____ | Create account alert | Identifies accounts that have not made the minimum budget payment, |
| Minimum budget payment too low for account balance | Budget plan modified  
Form template of <form selection> printed  
Guarantor balance less than $____ | Create account alert | Identifies Perpetual budgets accounts where the balance increased and the budget payment amount does not satisfy the required minimum defined in Practice Preferences > Budget tab |
<table>
<thead>
<tr>
<th>Auto-Creation Actions</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print statement indicator turned off for more than ___ days</td>
<td>Print statement indicator turned on</td>
<td>Create account alert</td>
<td>Identifies accounts that are not receiving a statement because the statement indicator is turned off on the account.</td>
</tr>
<tr>
<td></td>
<td>Account balance of $0.00</td>
<td>Create account alert</td>
<td></td>
</tr>
<tr>
<td>Third party balance greater than $_____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Third party balance less than $_____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total balance greater than $_____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total balance less than $_____</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Appointment Waitlist Task Options

The following is a list of the Auto-Create actions available for Tasks the source type “Appointment Waitlist”, along with the Auto-Complete actions that might be used in conjunction with them, and the available Auto-worker actions.

<table>
<thead>
<tr>
<th>Auto-Creation Actions</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waitlist batch update to match potential candidates to open appointment slots</td>
<td>• Waitlist completed successfully</td>
<td>N/A</td>
<td>• Identifies any open appointment slots that match the waitlist when the Scheduling Update process is run, either automatically during a nightly SQL job, or manually from within the EPM application from the File &gt; Processes &gt; Scheduling update menu option.</td>
</tr>
<tr>
<td></td>
<td>• Waitlist modified or deleted</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Waitlist no longer has open slot available</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Waitlist no longer matches open appointment slot due to another appointment being booked</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Waitlist matches open slot</td>
<td>• Waitlist completed successfully</td>
<td>N/A</td>
<td>• Identifies any appointment slots that become available that match the waitlist (e.g. another appointment is cancelled and a matching slot becomes available).</td>
</tr>
<tr>
<td></td>
<td>• Waitlist modified or deleted</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Waitlist no longer has open slot available</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Waitlist no longer matches open appointment slot due to another appointment being booked</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appointment Task Options

The following is a list of the Auto-Create options available for the source type “Appointment”, along with the Auto-Complete actions that might commonly be used in conjunction with them, as well as the and Auto-worker actions that are available for that function.

<table>
<thead>
<tr>
<th>Auto-Creation Actions</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes:</th>
</tr>
</thead>
<tbody>
<tr>
<td>An eligibility check is needed because it is &lt;<strong>&gt; day(s) until the appointment and no eligibility check has been performed in the last &lt;</strong>&gt; day(s)</td>
<td>• Appointment cancelled • Appointment cancelled at ________ location • Appointment deleted • Patient Expired</td>
<td>• Create chart alert</td>
<td>• Used with Real-time Transaction Server</td>
</tr>
<tr>
<td>An eligibility check resulted in a response status of &lt;____&gt;</td>
<td>• Appointment cancelled • Appointment cancelled at ________ location • Appointment deleted • Appointment kept/checked in • Patient Expired</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Appointment no longer matches the resource’s template due to a template exception</td>
<td>• Appointment cancelled • Appointment deleted • Appointment kept/checked in • Patient Expired</td>
<td>• Create chart alert</td>
<td>• Identifies appointments that need to be rescheduled when a Template Exception is made for a Resource</td>
</tr>
<tr>
<td>Appointment rescheduled</td>
<td>• Appointment cancelled • Appointment cancelled at ________ location • Appointment deleted</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>&lt;Event&gt; is scheduled</td>
<td>• Appointment cancelled • Appointment cancelled at ________ location • Appointment deleted • Form template of ________ printed • Patient Expired</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>&lt;Event&gt; is scheduled at &lt;Location&gt;</td>
<td>• Appointment cancelled • Appointment cancelled at ________ location • Appointment deleted • Form template of ________ printed • Patient Expired</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Auto-Completion Actions</td>
<td>Auto-Worker Actions</td>
<td>Notes:</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>First appointment in a recurring series</td>
<td>Create chart alert</td>
<td>When an appointment is made “recurring”, it tasks the original appointment.</td>
<td></td>
</tr>
<tr>
<td>Guarantor balance greater than $____</td>
<td>Create chart alert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last appointment in a recurring series</td>
<td>Create chart alert</td>
<td>When an appointment is made “recurring”, it tasks the final appointment.</td>
<td></td>
</tr>
<tr>
<td>Linked appointment rescheduled</td>
<td>Create chart alert</td>
<td>Only tasks the task to appointment that is actually rescheduled, not all linked appointments.</td>
<td></td>
</tr>
<tr>
<td>No referring physician</td>
<td>Create chart alert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No referring physician for &lt;Event&gt; at &lt;Location&gt;</td>
<td>Create chart alert</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rendering does not participate in primary insurance plan</td>
<td>Create chart alert</td>
<td>Looks at the first insurance in the patient’s demographic record. It does not consider secondary insurances or any insurances tied to relationships.</td>
<td></td>
</tr>
<tr>
<td>Rendering does not participate in primary insurance plan at &lt;Location&gt;</td>
<td>Create chart alert</td>
<td>Looks at the first insurance in the patient’s demographic record. It does not consider secondary insurances or any insurances tied to relationships.</td>
<td></td>
</tr>
</tbody>
</table>
**Chart Task Options**

The following is a list of the Auto-Create actions available for Tasks with the source type “Chart”, along with the Auto-Complete actions that might be used in conjunction with them, and the available Auto-worker actions.

Chart Tasks can also be automatically created from Recall Plans. The recall tasks create immediately when you update dates on the recall plan (File-Print – Forms) screen, regardless of any letters or label printing.

<table>
<thead>
<tr>
<th>Auto-Creation Actions</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>_____ days prior to appointment date</td>
<td>• Appointment cancelled</td>
<td>• Create chart alert</td>
<td>Tasks future appointments only</td>
</tr>
<tr>
<td></td>
<td>• Appointment deleted</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Patient Expired</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appointment cancelled</td>
<td>• Patient status of ________ assigned</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Appointment cancelled at &lt;Location&gt;</td>
<td>• Patient status of ________ assigned</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Appointment created</td>
<td>• Appointment cancelled</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Appointment deleted</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Patient Expired</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appointment deleted</td>
<td></td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Appointment no shows</td>
<td>• Appointment deleted</td>
<td>• Create chart alert</td>
<td>This task will create on any no show appointment. If the “Discontinue future auto-creation of this task type” option is selected, the task will not create again the next time the patient now shows.</td>
</tr>
<tr>
<td></td>
<td>• Patient status of ________ assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appointment no shows at &lt;Location&gt;</td>
<td>• Appointment deleted</td>
<td>• Create chart alert</td>
<td>*same as above</td>
</tr>
<tr>
<td></td>
<td>• Patient Expired</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Patient status of ________ assigned</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appointment rescheduled</td>
<td>• Appointment cancelled</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Appointment deleted</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Patient Expired</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document type of __________ is posted</td>
<td>• Document type of __________ is signed.</td>
<td>• Create chart alert</td>
<td>Used with ICS to identify documents posted to a patient’s chart</td>
</tr>
<tr>
<td><strong>Auto-Creation Actions</strong></td>
<td><strong>Auto-Completion Actions</strong></td>
<td><strong>Auto-Worker Actions</strong></td>
<td><strong>Notes</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------</td>
<td>-------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Document type of ________ is posted and document type requires a signature.</td>
<td>• Document type of ________ is signed.</td>
<td>• Create chart alert</td>
<td>• Used with ICS to identify documents which require signature.</td>
</tr>
<tr>
<td>Eligibility inquiry rejected with a rejection code of ________</td>
<td>• Appointment cancelled</td>
<td>• Create chart alert</td>
<td>• Used with RTS</td>
</tr>
<tr>
<td>Encounter deleted</td>
<td></td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>&lt;Event&gt; is scheduled at &lt;Location&gt; ________ days prior to appointment date</td>
<td>• Appointment cancelled at &lt;Location&gt;</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Future appointments scheduled past expiration date of eligibility</td>
<td>• Appointment cancelled</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Future appointments scheduled past expiration date of referral</td>
<td>• Appointment cancelled</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Patient Status of ________ assigned</td>
<td></td>
<td>• Create chart alert</td>
<td>• Task creates immediately when the specified status is attached to a patient.</td>
</tr>
<tr>
<td>Print statements indicator turned off for more than ___ days</td>
<td>• Print statements indicator turned on</td>
<td>• Create chart alert</td>
<td>• Identifies charts that have the Print Statements indicator turned off (Patient Chart &gt; Patient Information Tab &gt; Chart Details subtab).</td>
</tr>
<tr>
<td>Privacy Notice Reason set to ________</td>
<td>• Privacy notice reason set to ________</td>
<td>• Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Referral inquiry rejected with a rejection code of ________</td>
<td></td>
<td>• Create chart alert</td>
<td></td>
</tr>
</tbody>
</table>
Encounter Task Options

The following is a list of the Auto-Create actions available for Tasks with the source type “Encounter”, along with the Auto-Complete actions that might be used in conjunction with them, and the available Auto-worker actions.

Encounter tasks can also be automatically created from the Claim Edit Library. The task is assigned to the claim edit library and will create a task based on the criteria selected in Enterprise Preferences.

**Note:** System generated edits and contract edits will not create tasks.

<table>
<thead>
<tr>
<th>Auto-Creation Action</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Claim status received with category code of ______ | • Clean claim created  
• Encounter reaches History status  
• Third party payment posted | • Create chart alert | • Used with 227 Claim status imports |
| Claim status received with message of ______ | • Clean claim created  
• Encounter reaches History status  
• Third party payment posted | • Create chart alert | • Used with 227 Claim status imports |
| Claim status received with status code of _____ | • Clean claim created  
• Encounter reaches History status  
• Third party payment posted | • Create chart alert | • Used with 227 Claim status imports |
| Encounter is greater than ___ days old from <date option> and 3rd party balance is between $____ and $____ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status in <__> | • Clean claim created  
• Encounter reaches History status  
• Third party balance of $0.00  
• Third party payment greater than $____ posted  
• Third party payment posted | | • The fin class parameter ONLY affects the COB position defined. It does not consider the financial class of the outstanding balance.  
• The COB selection relates specifically to the financial class(es) selected.  
• This can be used for insurance credit balances (between -9999.99 and -0.01) |
<table>
<thead>
<tr>
<th>Auto-Creation Action</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encounter is greater than ___ days old from &lt;date option&gt; and COB1 balance is less than $___ for &lt;fin class/payer selection&gt; where fin class/payer is &lt;COB Selection&gt; and encounter status in ____</td>
<td>▪ Encounter reaches History status</td>
<td>▪ Create chart alert</td>
<td>• Not intended to identify credit balances.</td>
</tr>
<tr>
<td>Encounter is greater than ___ days old from &lt;date option&gt; and COB3 balance is less than $___ for &lt;fin class/payer selection&gt; where fin class/payer is &lt;COB Selection&gt; and encounter status in &lt;__&gt;</td>
<td>▪ Encounter reaches History status</td>
<td>▪ Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Encounter is greater than ___ days old from &lt;date option&gt; and COB1 balance is between $___ and $___ for &lt;fin class/payer selection&gt; where fin class/payer is &lt;COB Selection&gt; and encounter status in ____</td>
<td>▪ Clean claim created</td>
<td>▪ Create chart alert</td>
<td>• Identifies encounters with a primary insurance balance that meets the defined parameters.</td>
</tr>
<tr>
<td>Encounter is greater than ___ days old from &lt;date option&gt; and COB2 balance is between $___ and $___ for &lt;fin class/payer selection&gt; where fin class/payer is &lt;COB Selection&gt; and encounter status in ____</td>
<td>▪ Clean claim created</td>
<td>▪ Create chart alert</td>
<td></td>
</tr>
<tr>
<td>Auto-Creation Action</td>
<td>Auto-Completion Actions</td>
<td>Auto-Worker Actions</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Encounter is greater than <X> days old from <date option> and COB3 balance is between $____ and $____ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status in <__> | ▪ Clean claim created  
▪ Encounter reaches History status  
▪ Third party balance of $0.00 | ▪ Create chart alert | ▪ Identifies encounters with a tertiary insurance balance that meets the defined parameters.  
▪ The COB selection relates specifically to the financial class(es) selected.  
▪ This can be used for tertiary insurance credit balances (between -9999.99 and -0.01) |
| Encounter is greater than <__> days old from <date option> and COB2 balance is less than $____ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status in <__> | ▪ Encounter reaches History status  
▪ Form template of _____ printed  
▪ Third party balance of $0.00 | ▪ Create chart alert | ▪ Not intended to identify credit balances. |
| Encounter is greater than _____ days old from <date option> and 3rd party balance is less than $____ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status in _____ | ▪ Encounter reaches History status  
▪ Form template of _____ printed  
▪ Third party balance of $0.00 | ▪ Create chart alert | ▪ Not intended to identify credit balances. |
| Encounter is greater than _____ days old from <date option> and patient balance is between $___ and $____ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status is _____ | ▪ Encounter reaches Bad Debt status  
▪ Encounter reaches History status  
▪ Form template of _____ printed  
▪ Patient payment greater than $_____ posted. | ▪ Add collection letter of <____> to the encounter  
▪ Create chart alert  
▪ Small balance write off using <transaction code selection> for patient balance | ▪ Patient payment must be posted with a Source type of Encounter to satisfy the auto-complete requirement  
▪ This can be used to identify patient credit balances (between -9999.99 and -0.01) |
<table>
<thead>
<tr>
<th>Auto-Creation Action</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Encounter is greater than _____ days old from <date option> and patient balance is less than $_____ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status is _____ | - Encounter reaches History status  
- Form template of _____ printed | - Add collection letter of <_____> to the encounter  
- Create chart alert  
- Small balance write off using <transaction code selection> for patient balance | - Not intended to identify credit balances. |
| Encounter is greater than _____ days old from <date option> and total balance is between $___ and $___ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status is _____ | - Encounter reaches History status  
- Form template of _____ printed | - Create chart alert  
- Small balance write off using <transaction code selection> for patient balance;  
- <transaction code selection> for 3rd party balance. | - This can be used for credit balances (between -9999.99 and -0.01) |
| Encounter is greater than _____ days old from <date option> and total balance is greater than $___ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status is <_> | - Encounter reaches History status  
- Form template of _____ printed | - Create chart alert | - The COB selection relates specifically to the financial class (es) selected. |
| Encounter is greater than _____ days old from <date option> and total balance is less than $___ for <fin class/payer selection> where fin class/payer is <COB Selection> and encounter status is <_> | - Encounter reaches History status  
- Form template of _____ printed | - Create chart alert  
- Small balance write off using <transaction code selection> for patient balance;  
- <transaction code selection> for 3rd party balance. | - Not intended to identify credit balances. |
<p>| Encounter is put on hold | - Encounter reaches History status | - Create chart alert | - Will identify encounters put on hold in the future. It does not task any encounters that were already on hold when the task was created. |</p>
<table>
<thead>
<tr>
<th>Auto-Creation Action</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encounter pre-listed</td>
<td>• Encounter reaches History status</td>
<td>• Create chart alert</td>
<td>• Will identify encounters pre-listed in the future. It does not task encounters that were pre-listed before the task was created.</td>
</tr>
<tr>
<td></td>
<td>• Form template of &lt;_____&gt; printed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encounter reaches bad debt status</td>
<td></td>
<td>• Create chart alert</td>
<td>• Will identify encounters put in bad debt in the future. It does not task the encounters that are already in bad debt</td>
</tr>
<tr>
<td>Insurance verification is greater than &lt; &gt; days old</td>
<td></td>
<td>• Create chart alert</td>
<td>• Based on the Verification Date in the encounter insurance section of the patient chart.</td>
</tr>
<tr>
<td>No third party payment received for _____ days since the last third party payment received and third party balance is greater than $_____ for &lt;fin class/payer selection&gt; where fin class is &lt;COB Selection&gt;</td>
<td>• Encounter reaches History status</td>
<td>• Create chart alert</td>
<td>• Identifies encounters were a claim was processed and a third party payment was made, but there is still an outstanding insurance balance.</td>
</tr>
<tr>
<td></td>
<td>• Third party balance of $0.00</td>
<td>• Move balance from &lt;COB selection&gt; to &lt;COB selection&gt;</td>
<td>• Could be used to identify secondary insurance balances where the primary has already paid, or insurance balances where a partial payment was made.</td>
</tr>
<tr>
<td></td>
<td>• Third party payment greater than $_____ posted</td>
<td>• This creates a task and automatically completes it so it is available in the patient history</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Third party payment posted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No third party payment received for &lt; &gt; days since claim process date for &lt;fin class/payer selection&gt; where fin class/payer is &lt;COB Selection&gt;</td>
<td>• Encounter reaches History status</td>
<td>• Create chart alert</td>
<td>• Identifies encounters were a claim was processed and a third party payment has not been posted against that claim.</td>
</tr>
<tr>
<td></td>
<td>• Third party balance of $0.00</td>
<td>• Move balance from &lt;COB selection&gt; to &lt;COB selection&gt;</td>
<td>• This does not look at the current balance, just the claim process date.</td>
</tr>
<tr>
<td></td>
<td>• Third party payment greater than &lt;$___&gt; posted</td>
<td>• This creates a task and automatically completes it so it is available in the patient history</td>
<td>• If a partial payment has been made on the encounter, this task will not create.</td>
</tr>
<tr>
<td></td>
<td>• Third party payment posted</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payment received but not for the contractual allowed amount</td>
<td>• Form template of _____ printed</td>
<td>• Create chart alert</td>
<td>• Use the Contract Library for the allowed amount.</td>
</tr>
</tbody>
</table>

• Use the Contract Library for the allowed amount.
<table>
<thead>
<tr>
<th>Auto-Creation Action</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment received for <code>&lt;fin class/payer selection&gt;</code> where fin class payer is</td>
<td></td>
<td>▪ Create chart alert</td>
<td>▪ Identify encounters not receiving a statement because the Print Statement Indicator is turned off.</td>
</tr>
<tr>
<td><code>&lt;COB Selection&gt;</code>, <code>&lt;rendering selection&gt;</code>, <code>&lt;SIM Dept selection&gt;</code> where a contract is setup and the CPT 4 does not exist in the contract.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payment received for <code>&lt;fin class/payer selection&gt;</code> where fin class payer is</td>
<td></td>
<td>▪ Create chart alert</td>
<td>▪ Identify encounters not receiving a statement because the Print Statement Indicator is turned off.</td>
</tr>
<tr>
<td><code>&lt;COB Selection&gt;</code>, <code>&lt;SIM Dept selection&gt;</code> where a contract is setup and the CPT 4 does not exist in the contract.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payment received for <code>&lt;rendering selection&gt;</code>, <code>&lt;SIM Dept selection&gt;</code> where a contract is setup and the CPT 4 does not exist in the contract.</td>
<td></td>
<td>▪ Create chart alert</td>
<td>▪ Identify encounters not receiving a statement because the Print Statement Indicator is turned off.</td>
</tr>
<tr>
<td>Print statements indicator turned off for more than ___ days</td>
<td>▪ Encounter reaches Bad Debt status</td>
<td>▪ Create chart alert</td>
<td>▪ Identify encounters not receiving a statement because the Print Statement Indicator is turned off.</td>
</tr>
<tr>
<td>Reason code of _______ is used in conjunction with <code>&lt;SIM selection&gt;</code> and <code>&lt;fin class/payer selection&gt;</code> where fin class/payer is <code>&lt;COB selection&gt;</code></td>
<td>▪ Encounter reaches History status</td>
<td>▪ Create chart alert</td>
<td>▪ Identify encounters not receiving a statement because the Print Statement Indicator is turned off.</td>
</tr>
<tr>
<td>Reason code of _______ is used in conjunction with <code>&lt;SIM selection&gt;</code> and <code>&lt;modifier selection&gt;</code></td>
<td>▪ Encounter reaches History status</td>
<td>▪ Create chart alert</td>
<td>▪ Identify encounters not receiving a statement because the Print Statement Indicator is turned off.</td>
</tr>
<tr>
<td>Reason code of _______ is used in conjunction with <code>&lt;SIM selection&gt;</code>, <code>&lt;modifier selection&gt;</code> and <code>&lt;fin class/payer selection&gt;</code> where fin class/payer is <code>&lt;COB selection&gt;</code></td>
<td>▪ Encounter reaches History status</td>
<td>▪ Create chart alert</td>
<td>▪ Identify encounters not receiving a statement because the Print Statement Indicator is turned off.</td>
</tr>
<tr>
<td>Auto-Creation Action</td>
<td>Auto-Completion Actions</td>
<td>Auto-Worker Actions</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
<td>---------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reason code of _______ used on a posted payment</td>
<td>- Encounter reaches History status&lt;br&gt;- Third party balance of $0.00&lt;br&gt;- Third party payment greater than $_____ posted</td>
<td>- Create chart alert</td>
<td>- Identifies encounters were the specified <strong>line item</strong> reason code was used when posting a transaction (payment, adjustment or refund).</td>
</tr>
<tr>
<td>Reason code of &lt;____&gt; used on a posted transaction payment</td>
<td>- Encounter reaches History status&lt;br&gt;- Third party balance of $0.00&lt;br&gt;- Third party payment greater than $_____ posted</td>
<td>- Create chart alert</td>
<td>- Identifies encounters were the specified <strong>transaction level</strong> reason code was used when posting a transaction (payment, adjustment or refund).</td>
</tr>
</tbody>
</table>
Invoice Task Options

The following is a list of the Auto-Create actions available for Tasks with the source type “Invoice”, along with the Auto-Complete actions that might be used in conjunction with them, and the available Auto-worker actions.

<table>
<thead>
<tr>
<th>Auto-Creation Action</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice is greater than ___ days old from &lt;date selection&gt; and balance is greater than $____</td>
<td>• Invoice reaches history status</td>
<td>• Create account alert</td>
<td></td>
</tr>
</tbody>
</table>

User Task Options

User tasks can be automatically created from the Image Control System (ICS). Certain Document Types can be selected to automatically create a task when documents are scanned through ICS.

<table>
<thead>
<tr>
<th>Auto-Creation Action</th>
<th>Auto-Completion Actions</th>
<th>Auto-Worker Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fee Ticket Document Type of &lt;_____&gt; is posted</td>
<td></td>
<td></td>
<td>• This task is designed to automatically create when a batch of fee tickets are scanned into the ICS system and are ready for charge posting.</td>
</tr>
</tbody>
</table>